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This document provides instructions for integrating the phone system with Cisco Unity.

Integration Tasks
Before doing the following tasks to integrate Cisco Unity with the Ericsson MD-110 phone system, 
confirm that the Cisco Unity server is ready for the integration by completing the applicable tasks in the 
applicable Cisco Unity installation guide.

The following task lists describe the process for creating, changing, and deleting integrations.

Task List to Create the Integration
Use the following task list to set up a new integration with the Ericsson MD-110 phone system. If you 
are installing a new Cisco Unity server by using the applicable Cisco Unity installation guide, you may 
have already completed some of the following tasks.

1. Review the system and equipment requirements to confirm that all phone system and Cisco Unity 
server requirements have been met. See the “Requirements” section on page 2.

2. Plan how the voice messaging ports will be used by Cisco Unity. See the “Planning How the Voice 
Messaging Ports Will Be Used by Cisco Unity” section on page 4.

3. Program the Ericsson MD-110 phone system and extensions. See the “Programming the Ericsson 
MD-110 Phone System” section on page 6.

4. Create the integration. See the “Creating a New Integration with the Ericsson MD-110 Phone 
System” section on page 8.

5. Test the integration. See the “Testing the Integration” section on page 12.

6. If you have a secondary server for Cisco Unity failover, integrate the secondary server. See the 
“Integrating a Secondary Server for Cisco Unity Failover” section on page 15.
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Task List to Make Changes to an Integration
Use the following task list to make changes to an integration after it has been created.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the “Changing the Settings for 
an Existing Integration” section on page 19.

2. Make the changes you want to the existing integration. See the “Changing the Settings for an 
Existing Integration” section on page 19.

Task List to Delete an Existing Integration
Use the following task list to remove an existing integration.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the “Deleting an Existing 
Integration” section on page 19.

2. Delete the existing integration. See the “Deleting an Existing Integration” section on page 19.

Requirements
The Ericsson MD-110 integration supports configurations of the following components:

Phone System

• Ericsson MD-110.

• Software level BC6 or later.

• ICU card installed to provide the serial data port.

• The serial data port in the phone system connected to a serial port (COM1 is the default) on the 
Cisco Unity server with an RS-232 serial cable.

We recommend that the serial cable have the following construction:

– A maximum of 50 feet (15.24 m) in length

– 24 AWG stranded conductors

– Low capacitance—for example, no more than 12 pF/ft (39.4 pF/m) between conductors

– At least 65 percent braided shield over aluminized polymer sleeve around conductors

– UL-recognized overall cable jacket insulation with low dielectric constant

– Braided shield fully terminated to and enclosed by a metal connector backshell

– Gold-plated connector contacts

• The voice messaging ports in the phone system connected to the voice cards in the Cisco Unity 
server.

• The phone system ready for the integration as described in the installation guide for the phone 
system.

Cisco Unity Server

• The applicable voice cards, installed. For details, refer to the “Supported Circuit-Switched Phone 
System Integrations” section in your version of Cisco Unity System Requirements at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.
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• Cisco Unity installed and ready for the integration, as described in the applicable Cisco Unity 
installation guide at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

• A license that enables the applicable number of voice messaging ports.

• An available serial port (COM1 is the default).

Caution When the Cisco Unity server is restarted, the analog voice messaging ports on the phone system that are 
connected to the Cisco Unity server will freeze for approximately two minutes.

In addition, if Cisco Unity is configured for failover and the primary server is restarted, the phone system 
will not send calls to the active secondary server for approximately two minutes.

In either case, the workaround is to disconnect the RS-232 serial cable from the Cisco Unity server 
before restarting the server. (When Cisco Unity is configured for failover, disconnect the serial cable 
only on the server that will be restarted.) After the server has restarted, reconnect the serial cable.

Integration Description
The Ericsson MD-110 integration uses a data link, which consists of an RS-232 serial cable connecting 
the phone system and the Cisco Unity server. The voice messaging lines from the phone system connect 
to the analog voice cards in the Cisco Unity server. Figure 1 shows the required connections.

Figure 1 Connections Between the Phone System and Cisco Unity

Call Information
The phone system sends the following information through the data link:

• The extension of the called party

• The extension of the calling party (for internal calls) or the phone number of the calling party (if it 
is an external call and the system uses caller ID)

• The reason for the forward (the extension is busy, does not answer, or is set to forward all calls)

Cisco Unity uses this information to answer the call appropriately. For example, a call forwarded to 
Cisco Unity is answered with the personal greeting of the subscriber. If the phone system routes the call 
to Cisco Unity without this information, Cisco Unity answers with the opening greeting.

RS-232 serial cable
Analog lines

Cisco Unity server
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3
Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0

OL-3113-08

http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html


 

Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0
Planning How the Voice Messaging Ports Will Be Used by Cisco Unity
Integration Functionality
The Ericsson MD-110 integration with Cisco Unity provides the following integration features:

• Call forward to personal greeting

• Call forward to busy greeting

• Caller ID

• Easy message access (a subscriber can retrieve messages without entering an ID because 
Cisco Unity identifies the subscriber based on the extension from which the call originated; a 
password may be required)

• Identified subscriber messaging (Cisco Unity identifies the subscriber who leaves a message during 
a forwarded internal call, based on the extension from which the call originated)

• Message waiting indication (MWI)

Integrations with Multiple Phone Systems
Depending on the version, Cisco Unity can be integrated with two or more phone systems:

• Cisco Unity 4.0 and 4.1 can be integrated with a maximum of two phone systems at one time. For 
information on and instructions for integrating Cisco Unity with two phone systems, refer to the 
Dual Phone System Integration Guide at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/integuid/multi/itmultin.htm.

• Cisco Unity 4.2 and later can be integrated with two or more phone systems at one time. For 
information on the maximum supported combinations and instructions for integrating Cisco Unity 
with multiple phone systems, refer to the Multiple Phone System Integration Guide at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/integuid/multi/multcu42.htm.

Planning How the Voice Messaging Ports Will Be Used by 
Cisco Unity

Before programming the phone system, you need to plan how the voice messaging ports will be used by 
Cisco Unity. The following considerations will affect the programming for the phone system (for 
example, setting up the hunt group or call forwarding for the voice messaging ports):

• The number of voice messaging ports installed.

• The number of voice messaging ports that will answer calls.

• The number of voice messaging ports that will only dial out, for example, to send message 
notification, to set message waiting indicators (MWIs), to make AMIS deliveries, and to make 
telephone record and playback (TRAP) connections.

The following table describes the voice messaging port settings in Cisco Unity that can be set in UTIM, 
and that are displayed as read-only text on the System > Ports page of the Cisco Unity Administrator.
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The Number of Voice Messaging Ports to Install

The number of voice messaging ports to install depends on numerous factors, including:

• The number of calls Cisco Unity will answer when call traffic is at its peak.

• The expected length of each message that callers will record and that subscribers will listen to.

• The number of subscribers.

• The number of ports that will be set to dial out only.

• The number of calls made for message notification.

• The number of MWIs that will be activated when call traffic is at its peak.

• The number of AMIS delivery calls.

• The number of TRAP connections needed when call traffic is at its peak. (TRAP connections are 
used by Cisco Unity web applications and e-mail clients to play back and record over the phone.)

• The number of calls that will use the automated attendant and call handlers when call traffic is at its 
peak.

Table 1 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a 
ringing tone but are not answered. Typically, the port is disabled only by the installer during 
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be incoming 
calls from unidentified callers or from subscribers.

Message Notification Check this check box to designate the port for notifying subscribers of messages. Assign 
Message Notification to the least busy ports.

Dialout MWI

(not used by serial or SMDI 
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MWI 
to the least busy ports.

AMIS Delivery

(available with the AMIS 
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voice 
messages from Cisco Unity subscribers to users on another voice messaging system. 
Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol, 
which provides an analog mechanism for transferring voice messages between different 
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long 
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule 
page so that outgoing AMIS calls are placed during closed hours or at times when 
Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playback 
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the 
least busy ports.
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It is best to install only the number of voice messaging ports that are needed so that system resources are 
not allocated to unused ports.

The Number of Voice Messaging Ports That Will Answer Calls

The calls that the voice messaging ports answer can be incoming calls from unidentified callers or from 
subscribers. Typically, the voice messaging ports that answer calls are the busiest.

You can set voice messaging ports to both answer calls and to dial out (for example, to send message 
notifications). However, when the voice messaging ports perform more than one function and are very 
active (for example, answering many calls), the other functions may be delayed until the voice messaging 
port is free (for example, message notifications cannot be sent until there are fewer calls to answer). For 
best performance, dedicate certain voice messaging ports for only answering incoming calls, and 
dedicate other ports for only dialing out. Separating these port functions eliminates the possibility of a 
collision, in which an incoming call arrives on a port at the same time that Cisco Unity takes the port 
off-hook to dial out.

The Number of Voice Messaging Ports That Will Only Dial Out, and Not Answer Calls

Ports that will only dial out and will not answer calls can do one or more of the following:

• Notify subscribers by phone, pager, or e-mail of messages that have arrived.

• Turn MWIs on and off for subscriber extensions.

• Make outbound AMIS calls to deliver voice messages from Cisco Unity subscribers to users on 
another voice messaging system. (This action is available only with the AMIS licensed feature.)

• Make a TRAP connection so that subscribers can use the phone as a recording and playback device 
in Cisco Unity web applications and e-mail clients.

Typically, these voice messaging ports are the least busy ports.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity that cannot 
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging 
port is set only to Dialout MWI, do not send calls to it.

Preparing for Programming the Phone System

Record your decisions about the voice messaging ports to guide you in programming the phone system.

Programming the Ericsson MD-110 Phone System
If you use programming options other than those supplied in the following procedure, the performance 
of the integration may be affected.

Do the following procedure.

To Program the Ericsson MD-110 Phone System

Step 1 Use the EXTEI command to program the ELU extensions for connecting to the voice messaging ports. 
You must program the ports for:

• No call waiting

• No diversion
6
Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0

OL-3113-08



 

Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0
Programming the Ericsson MD-110 Phone System
• No conferencing

• No intrusion

The ELU1 extension does not support message waiting indication for analog phones. The ELU24 
extension provides stutter dial tone for message waiting indication.

Step 2 Use the VMPOI command to match the extensions and their ICU port numbers with the voice messaging 
ports on the Cisco Unity server. For example, the Cisco Unity port 01 must match Ericsson ICU port 1, 
extension 3500; Cisco Unity port 02 must match Ericsson ICU port 2, extension 3501; and so on. The 
results of this example would be as follows:

VMPOI:ICUIND=1,DIR=3500,PORT=01
VMPOI:ICUIND=2,DIR=3501,PORT=02

Step 3 Use the GH command to create a hunt group for the voice messaging ports.

Make sure that the phone system sends calls only to Cisco Unity voice ports that are set to Answer Calls 
on the System > Ports page in the Cisco Unity Administrator. Calls sent to a voice port not set to Answer 
Calls cannot be answered by Cisco Unity and may cause other problems.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity 
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, 
if a voice messaging port is set only to Dialout MWI, do not send calls to it.

Step 4 Use the VMPOI command to associate the hunt group with Cisco Unity.

Step 5 Use the KS command to provide message waiting indication on DTS phones.

Step 6 Program each phone to forward calls to the pilot number assigned to the voice messaging ports, based 
on one of the Cisco Unity call transfer types shown in Table 2.

Note You can use alternate extensions to create multiple line appearances, enable easy message access from 
cell phones, and simplify addressing messages to subscribers at different locations in Cisco Unity. 
Enabling alternate MWIs lets Cisco Unity turn MWIs on at more than one extension. For details, see the 
“Appendix: Using Alternate Extensions and MWIs” section on page 20.

Table 2 Call Transfer Types

Transfer Type Usage

Release transfer
(blind transfer)

Program the phone to forward calls to the pilot number when:

• The extension is busy

• The call is not answered

Supervised transfer Program the phone to forward calls to the pilot number only when the 
call is not answered. Confirm that call forwarding is disabled when the 
extension is busy.
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Creating a New Integration with the Ericsson MD-110 Phone 
System

After ensuring that the Ericsson MD-110 phone system and the Cisco Unity server are ready for the 
integration, do the following procedures to set up the integration and to enter the port settings.

To Create an Integration

Step 1 If UTIM is not already open, on the Windows Start menu of the Cisco Unity server, click Programs > 
Cisco Unity > Manage Integrations. UTIM appears.

Step 2 In the left pane of the UTIM window, click Cisco Unity Server.

Step 3 On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard 
appears.

Step 4 On the Welcome page, click the applicable phone system type, depending on your version of 
Cisco Unity:

• Cisco Unity 4.2 or later—Circuit-Switched via Voice Cards

• Cisco Unity 4.0 or 4.1—Circuit-Switched (Traditional PBX)

Step 5 Click Next.

Step 6 On the Name the Phone System Integration page, accept the default name or enter the phone system 
name to identify this integration, then click Next.

Step 7 On the Select Integration Method page, click Serial, then click Next.

Step 8 On the Select Phone System Manufacturer page, click the following settings, then click Next.

Step 9 On the Select Serial Integration Packet Settings page, enter the following settings, then click Next.

Step 10 On the Select COM Port Settings page, enter the following settings, then click Next.

Table 3 Settings for the Select Phone System Manufacturer Page

Field Setting

Manufacturer Ericsson

Model MD 110

Software Version All

Configuration File <if you have made copies of the .ini configuration file, the name of the 
configuration file that you want to use>

Table 4 Settings for the Select Serial Integration Packet Settings Page

Field Setting

Station Field Length <the station prefix plus the default extension length; accept the default or click 
another setting; this length is either 10 or 7>

Default Extension 
Length

<the default length of extensions on the phone system; accept the default or 
click another setting>
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Step 11 On the Set Number of Voice Messaging Ports page, enter the number of voice messaging ports on 
Cisco Unity that you want to connect to the phone system, then click Next.

This number cannot be more than the number of ports on the installed voice cards or the number of ports 
set up on the phone system.

Step 12 If other integrations already exist, the Enter Trunk Access Code page appears. Enter the extra digits that 
Cisco Unity must use to transfer calls through the gateway to extensions on the other phone systems with 
which it is integrated. Then click Next.

Step 13 (Cisco Unity 4.2 and later only) On the Reassign Subscribers page, any subscribers whose phone system 
integration has been deleted and who are not currently assigned to a phone system integration will appear 
in the list.

If no subscribers appear in the list, click Next and continue to Step 14.

Otherwise, select the subscribers that you want to assign to this phone system integration and click Next. 
You can use the following selection controls for selecting subscribers.

Step 14 (Cisco Unity 4.2 and later only) On the Reassign Call Handlers page, any call handlers whose phone 
system integration has been deleted and that are not currently assigned to a phone system integration will 
appear in the list.

If no call handlers appear in the list, click Next and continue to Step 15.

Otherwise, select the call handlers that you want to assign to this phone system integration and click 
Next. You can use the following selection controls for selecting call handlers.

Table 5 Settings for the Select COM Port Settings Page

Field Setting

COM Port <the communications port on the Cisco Unity server that will receive the call 
information; typically, this setting is 1>

Baud Rate <the baud rate that the phone system uses>

Data Bits <the number of data bits that the phone system uses>

Stop Bits <the number of stop bits that the phone system uses>

Parity <the parity that the phone system uses>

Table 6 Selection Controls for the Reassign Subscribers Page

Selection Control Effect

Check All Checks the check boxes for all subscribers in the list.

Uncheck All Unchecks the check boxes for all subscribers in the list.

Toggle Selected For the subscribers highlighted in the list, toggles between checking and 
unchecking the check boxes.

If some highlighted subscriber check boxes are checked and others are 
unchecked, clicking this button will check all the check boxes. Clicking again 
will uncheck all the check boxes.
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Step 15 On the Completing page, verify the settings you entered, then click Finish.

Step 16 At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity services in UTIM on the Tools menu by clicking Restart 
Cisco Unity.

To Enter the Voice Messaging Port Settings for the Integration

Step 1 After the Cisco Unity services restart, on the View menu, click Refresh.

Step 2 In the left pane of the UTIM window, expand the phone system integration that you are creating.

Step 3 In the left pane, click the name of the phone system.

Step 4 In the right pane, click the Ports tab.

Step 5 Enter the settings shown in Table 8 for the voice messaging ports.

For best performance, use the first voice messaging ports for incoming calls and the last ports to dial out. 
This helps minimize the possibility of a collision, in which an incoming call arrives on a port at the same 
time that Cisco Unity takes the port off-hook to dial out.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity 
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, 
if a voice messaging port is set only to Message Notification, do not send calls to it.

Table 7 Selection Controls for the Reassign Call Handlers Page

Selection Control Effect

Check All Checks the check boxes for all call handlers in the list.

Uncheck All Unchecks the check boxes for all call handlers in the list.

Toggle Selected For the call handlers highlighted in the list, toggles between checking and 
unchecking the check boxes.

If some highlighted call handler check boxes are checked and others are 
unchecked, clicking this button will check all the check boxes. Clicking again 
will uncheck all the check boxes.

Table 8 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a 
ringing tone but are not answered. Typically, the port is disabled only by the installer during 
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be incoming 
calls from unidentified callers or from subscribers.
10
Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0

OL-3113-08



 

Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0
Creating a New Integration with the Ericsson MD-110 Phone System
Step 6 Click Save.

Step 7 Exit UTIM.

If the phone system uses extension numbers that begin with zero (for example, 0123 or 09876), do the 
following procedure.

Note that after the procedure is done all extension numbers must have the same number of digits. In this 
case, for example, 0123 and 1234 are both allowed, but 0123 and 234 are not allowed. The extension 234 
would be interpreted as 0234.

To Enable Extensions Beginning with Zero

Step 1 On the Windows Start menu, click Programs > Cisco Unity > Manage Integrations. UTIM appears.

Step 2 In the left pane of the UTIM window, click the phone system integration, and click the Properties node.

Step 3 In the right pane of the UTIM window, click the Integration tab.

Step 4 Note the name of the Switch.ini file that appears in the Configuration File field.

Step 5 Exit UTIM.

Step 6 On the Windows Start menu, click Programs > Accessories > Notepad. The Notepad window appears.

Step 7 On the File menu, click Open.

Step 8 In the Open dialog box, browse to the \CommServer\IntLib directory, and double-click the name of the 
Switch.ini file you noted in Step 4.

Step 9 In the Configuration section of the file, insert the following line:

Message Notification Check this check box to designate the port for notifying subscribers of messages. Assign 
Message Notification to the least busy ports.

Dialout MWI

(not used by serial or SMDI 
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MWI 
to the least busy ports.

AMIS Delivery

(available with the AMIS 
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voice 
messages from Cisco Unity subscribers to users on another voice messaging system. 
Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol, 
which provides an analog mechanism for transferring voice messages between different 
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long 
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule 
page so that outgoing AMIS calls are placed during closed hours or at times when 
Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playback 
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the 
least busy ports.

Table 8 Settings for the Voice Messaging Ports (continued)

Field Considerations
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AllowZeroLeadingExtensions=1

If the line is already present in the Configuration section, confirm that the final digit is 1.

Step 10 Save the file, and exit Notepad.

Step 11 For the settings to take effect, restart the Cisco Unity server.

Testing the Integration
To test whether Cisco Unity and the phone system are integrated correctly, do the following procedures 
in the order listed.

If any of the steps indicate a failure, refer to the following documentation as applicable:

• The installation guide for the phone system.

• Cisco Unity Troubleshooting Guide, available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_troubleshooting_guides_list.html.

• The setup information earlier in this guide.

To Set Up the Test Configuration

Step 1 Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Cisco Unity is 
connected to.

Step 2 Set Phone 1 to forward calls to the Cisco Unity pilot number when calls are not answered.

Caution The phone system must forward calls to the Cisco Unity pilot number in no fewer than four 
rings. Otherwise, the test may fail.

Step 3 In the Cisco Unity Administrator, create a test subscriber to use for testing by doing the applicable 
substeps below.

If your message store is Microsoft Exchange, do the following:

a. In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

b. Click the Add icon.

c. Select New Exchange Subscriber.

d. On the Add Subscriber page, enter the applicable information.

e. Click Add.

If your message store is IBM Lotus Domino, do the following:

a. In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

b. Click the Add icon.

c. Click Notes.

d. In the Address Book list, confirm that the address book listed is the one that contains the user data 
that you want to import.
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If the address book that you want to use is not listed, go to the System > Configuration > 
Subscriber Address Books page and add a different address book.

e. In the Find Domino Person By list, indicate whether to search by short name, first name, or last 
name.

f. Enter the applicable short name or name. You also can enter * to display a list of all users, or enter 
one or more characters followed by * to narrow your search.

g. Click Find.

h. On the list of matches, click the name of the user to import.

i. On the Add Subscriber page, enter the applicable information.

j. Click Add.

Step 4 In the Extension field, enter the extension of Phone 1.

Step 5 In the Active Schedule field, click All Hours - All Days.

Step 6 Click the Save icon.

Step 7 In the navigation bar, click Call Transfer to go to the Subscribers > Subscribers > Call Transfer page 
for the test subscriber.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Settings” 
section in the Cisco Unity Administrator Help.

Step 8 Under Transfer Incoming Calls, click Yes, Ring Subscriber’s Extension, and confirm that the extension 
number is for Phone 1.

Step 9 Under Transfer Type, click Release to Switch.

Step 10 Click the Save icon.

Step 11 In the navigation bar, click Messages to go to the Subscribers > Subscribers > Messages page for the test 
subscriber.

Step 12 Under Message Waiting Indicators (MWIs), check Use MWI for Message Notification.

Step 13 In the Extension field, enter x.

Step 14 Click the Save icon.

Step 15 Open the Status Monitor by doing one of the following:

• In Internet Explorer, go to http://<Cisco Unity server name>/web/sm.

• Double-click the desktop shortcut to the Status Monitor.

• In the status bar next to the clock, right-click the Cisco Unity tray icon and click Status Monitor.

To Test an External Call with Release Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside 
callers use to dial directly to Cisco Unity.

Step 2 On the Status Monitor, note which port handles this call.

Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting 
means that the port is configured correctly.

Step 4 Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone means 
that Cisco Unity correctly released the call and transferred it to Phone 1.
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Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.” This 
state means that release transfer is successful.

Step 6 Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to 
Cisco Unity and that you hear the greeting for the test subscriber. Hearing the greeting means that the 
phone system forwarded the unanswered call and the call-forward information to Cisco Unity, which 
correctly interpreted the information.

Step 7 On the Status Monitor, note which port handles this call.

Step 8 Leave a message for the test subscriber and hang up Phone 2.

Step 9 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state 
means that the port was successfully released when the call ended.

Step 10 Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and 
Cisco Unity are successfully integrated for turning on MWIs.

To Test Listening to Messages

Step 1 From Phone 1, enter the internal pilot number for Cisco Unity.

Step 2 When asked for your password, enter the default password. Hearing the request for your password means 
that the phone system sent the necessary call information to Cisco Unity, which correctly interpreted the 
information.

Step 3 Confirm that you hear the recorded voice name for the test subscriber (if you did not record a voice name 
for the test subscriber, you will hear the extension number for Phone 1). Hearing the voice name means 
that Cisco Unity correctly identified the subscriber by the extension.

Step 4 When asked whether you want to listen to your message, press 1.

Step 5 After listening to the message, press 3 to delete the message.

Step 6 Confirm that the MWI on Phone 1 is deactivated. The deactivated MWI means that the phone system and 
Cisco Unity are successfully integrated for turning off MWIs.

Step 7 Hang up Phone 1.

Step 8 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state 
means that the port was successfully released when the call ended.

To Set Up Supervised Transfer on Cisco Unity

Step 1 In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Call Transfer page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in the title 
bar, then click Find, and select the name of the test subscriber in the list that appears.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Settings” 
section in the Cisco Unity Administrator Help.

Step 2 Under Transfer Type, click Supervise Transfer.

Step 3 Set the Rings to Wait For field to 3.

Step 4 Click the Save icon.
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To Test Supervised Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside 
callers use to dial directly to Cisco Unity.

Step 2 On the Status Monitor, note which port handles this call.

Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting 
means that the port is configured correctly.

Step 4 Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should 
hear the indication your phone system uses to mean that the call is on hold (for example, music or beeps).

Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This 
state and hearing an indication that you are on hold mean that Cisco Unity is supervising the transfer.

Step 6 Confirm that, after three rings, you hear the greeting for the test subscriber. Hearing the greeting means 
that Cisco Unity successfully recalled the supervised-transfer call.

Step 7 During the greeting, hang up Phone 2.

Step 8 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state 
means that the port was successfully released when the call ended.

To Delete the Test Subscriber

Step 1 In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in the title 
bar, then click Find, and select the name of the test subscriber in the list that appears.

Step 2 In the title bar, click the Delete Subscriber icon (the X).

Step 3 Click Delete.

Integrating a Secondary Server for Cisco Unity Failover
The Cisco Unity failover feature enables a secondary server to provide voice messaging services when 
the primary server becomes inactive. For information on installing a secondary server for failover, refer 
to the applicable Cisco Unity installation guide, available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

For information on failover, refer to the Cisco Unity Failover Configuration and Administration Guide. 
The Domino version of the guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/dom/index.htm. The 
Exchange version of the guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/ex/index.htm.
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Requirements
The following components are required to integrate a secondary server:

Phone System

• A serial data port for the data link.

• A data splitter unit to split the single data link into two serial cables.

• Two additional RS-232 serial cables (to be used with the serial cable from the integration of the 
primary server). With the three serial cables, connect one from the data port in the phone system to 
the data splitter unit; connect the second from the data splitter unit to the serial port on the primary 
server; and connect the third from the data splitter unit to the serial port on the secondary server.

Cisco Unity Server

• One secondary server for each primary server installed and ready for the integration, as described in 
the applicable Cisco Unity installation guide and earlier in this integration guide.

• The applicable cable configuration for each analog voice messaging port to simultaneously connect 
the phone system to the corresponding ports on both the primary and the secondary servers. For 
example, connect port 1 on the phone system with both port 1 on the primary server and port 1 on 
the secondary server.

• A license that enables failover.

Integration Description
The phone system uses a data link to send call information to the primary and secondary servers. The 
data splitter unit splits the single serial cable into two serial cables, enabling the data link to connect to 
the primary and secondary servers. The analog voice messaging lines from the phone system provide 
voice connectivity to the primary and secondary servers. Figure 2 shows the required connections.

Figure 2 Connections Between the Phone System and Cisco Unity Servers

The primary and secondary servers act in the following manner:

• When the primary server is operating normally, the secondary server is inactive.

• When the primary server becomes inactive, the secondary server becomes active.

• When the primary server becomes active again, the secondary server becomes inactive.

69
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Setting Up the Secondary Server for Failover
Do the following procedure to integrate the secondary server.

To Set Up the Secondary Server for Failover

Step 1 Install a secondary server with the same configuration as the primary server. For installation instructions, 
refer to the applicable Cisco Unity installation guide.

Step 2 Make all voice connections from the phone system to the corresponding ports on both the primary server 
and the secondary server. For example, connect port 1 from the phone system with port 1 on both the 
primary and the secondary servers.

Step 3 Connect one serial cable from the serial port on the phone system to the data splitter unit.

Step 4 Connect the remaining two serial cables to the two serial ports on the data splitter unit. Then connect 
one serial cable to the serial port on the primary server and the other serial cable to the serial port on the 
secondary server.

Step 5 On the Windows Start menu of the secondary server, click Programs > Cisco Unity > Manage 
Integrations. The UTIM window appears.

Step 6 On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard 
appears.

Step 7 Enter the settings to match the integration settings on the primary server.

Note We recommend not reassigning any unassigned subscribers and call handlers to the new 
integration, if you are asked by the wizard. Failover replication will automatically assign the 
correct integration.

Step 8 At the prompt to restart the Cisco Unity services, click Yes.

Note When restarting the Cisco Unity services, use the UTIM prompt instead of the Cisco Unity icon 
in the Windows taskbar. The taskbar icon does not restart all of the Cisco Unity services.

Step 9 After Cisco Unity restarts, on the Windows Start menu of the Cisco Unity server, click Programs > 
Cisco Unity > Manage Integrations. UTIM appears.

Step 10 In the left pane of the UTIM window, click the phone system integration that you created in Step 6.

Step 11 For Cisco Unity 4.0 and 4.1, continue to Step 12.

For Cisco Unity 4.2 and later, do the following substeps.

a. In the right pane, click Properties.

b. On the Integration tab, compare the setting of the Integration ID field for the secondary server to the 
setting of the Integration ID field for the primary server.

c. If the integration IDs of the phone system on the primary and secondary server are the same, 
continue to Step 12.

If the integration IDs of the phone system on the primary and secondary servers are different, on the 
secondary server, click Modify Integration ID.

d. When cautioned that subscribers associated with the current Integration ID setting will not be 
automatically associated with the new Integration ID setting, click OK.
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e. In the Modify Integration ID dialog box, in the Enter New Integration ID field, enter the Integration 
ID setting for the phone system on the primary server and click OK.

f. Click Save.

g. At the prompt to restart the Cisco Unity services, click No.

h. In the left pane, click the phone system integration that you created in Step 6.

Step 12 In the right pane of the UTIM window, click the Ports tab.

Step 13 Enter the port settings to match the port settings on the primary server.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity 
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, 
if a voice messaging port is set only to Dialout MWI, do not send calls to it.

Step 14 Click Save.

Step 15 Exit UTIM.

Step 16 Click Programs > Cisco Unity > Edit Switch Utility.

Step 17 In the Switch Configuration Editor window, in the Manufacturer field, click Ericsson.

Step 18 In the Model field, click MD 110.

Step 19 Click Edit.

Step 20 In the Switch Configuration dialog box, click the Incoming Calls tab.

Step 21 In the Call Rings field, enter 3 and click OK.

Step 22 In the Switch Configuration Editor dialog box, click Exit.

Step 23 On the Windows Start menu, click Run.

Step 24 Enter Regedit and click OK.

Caution Changing the wrong registry key or entering an incorrect value can cause the server to 
malfunction. Before you edit the registry, confirm that you know how to restore it if a problem 
occurs. (Refer to the “Restoring” topics in Registry Editor Help.) If you have any questions 
about changing registry key settings, contact Cisco TAC.

Step 25 If you do not have a current backup of the registry, click Registry > Export Registry File, and save the 
registry settings to a file.

Step 26 Expand the key HKEY_LOCAL_MACHINE\Software\Active Voice\Miu\1.0\Initialization.

Step 27 Double-click New Call Delay on Inactive Backup Server.

Step 28 In the Edit DWORD Value dialog box, in the Value Data field, enter 0, and click OK.

Step 29 Close the Registry Editor.

Step 30 Restart the Cisco Unity server.

No changes to the hunt group programming on the phone system are necessary.
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Changing the Settings for an Existing Integration
After the integration is set up, if you want to change any of its settings (for example, to add or remove 
voice messaging ports for an integration), do the following procedure.

To Change the Settings for an Integration

Step 1 On the Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > Manage 
Integrations. The UTIM window appears.

Step 2 In the left pane, double-click Unity Server. The existing integrations appear.

Step 3 Click the integration you want to modify.

Step 4 In the right pane, click the name of the cluster, phone system, or PIMG unit (depending on your 
integration) for the integration.

Step 5 In the right pane, click the applicable tab for the integration.

Step 6 Enter new settings in the fields that you want to change.

Caution If you are adding or removing voice messaging ports, make sure you change the settings for 
the individual ports so that there are an appropriate number of ports set to answer calls and an 
appropriate number of ports set to dial out.

Step 7 In the UTIM window, click Save.

Step 8 If prompted, restart the Cisco Unity services.

Deleting an Existing Integration
If you want to delete an existing integration (for example, you have replaced the phone system with 
which Cisco Unity originally integrated), do the following procedure.

To Delete an Existing Integration

Step 1 On the Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > Manage 
Integrations. The UTIM window appears.

Step 2 In the left pane, double-click Unity Server. The existing integrations appear.

Step 3 Click the integration that you want to delete.

Step 4 On the Integration menu, click Delete.

Step 5 Follow the on-screen instructions to assign the subscribers of the deleted phone system integration to 
another phone system integration.

Step 6 At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity services in UTIM on the Tools menu by clicking Restart 
Cisco Unity.
19
Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0

OL-3113-08



 

Appendix: Using Alternate Extensions and MWIs
Alternate Extensions
Step 7 If the integration you deleted used voice cards, remove the voice cards from the Cisco Unity server.

Appendix: Using Alternate Extensions and MWIs

Alternate Extensions
In addition to the “primary” extension that you specify for subscribers, you can assign subscribers up to 
nine alternate extensions. (The primary extension is the one that you assign to each subscriber when you 
create his or her subscriber account; it is listed on the Subscribers > Subscribers > Profile page.) 

Reasons to Use Alternate Extensions

There are several reasons that you may want to specify alternate extensions for subscribers. For example, 
if you have more than one Cisco Unity server that accesses a single, corporate-wide directory, you may 
want to use alternate extensions to simplify addressing messages to subscribers at the different locations. 
With alternate extensions, the number that a subscriber uses when addressing a message to someone at 
another location can be the same number that the subscriber dials when calling. You may also want to 
use alternate extensions to:

• Handle multiple line appearances on subscriber phones.

• Offer easy message access on direct calls from a cell phone, home phone, or phone at an alternate 
work site (assuming that the phone number is passed along to Cisco Unity from these other phone 
systems). In addition, when such phones are used as alternate extensions, and are set to forward to 
Cisco Unity, callers can listen to the subscriber greeting, and leave messages for the subscriber just 
as they would when dialing the primary extension for the subscriber.

Tip To reduce the number of requests from subscribers who want alternate extensions set up for 
multiple cell phones, home phones, and other phones, give subscribers class of service (COS) 
rights to specify their own set of alternate extensions. (See the Subscribers > Class of Service > 
Profile page.) With proper COS rights, a subscriber can specify up to five alternate extensions 
in the Cisco Unity Assistant—in addition to the nine that you can specify on the Subscribers > 
Alternate Extensions page in the Cisco Unity Administrator.

• Enable URL-based extensions in Cisco Unity for an integration with a SIP phone system.

How Alternate Extensions Work

Before you set up alternate extensions, review the following list for information on how alternate 
extensions work:

• Alternate extensions cannot exceed 30 characters in length. By default, each administrator-defined 
alternate extension must be at least 3 characters in length, while subscriber-defined alternate 
extensions must be at least 10 characters. 
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You can use the Advanced Settings tool in Tools Depot to specify a minimum extension length for 
the extensions entered in the Cisco Unity Administrator and the Cisco Unity Assistant. Refer to the 
Advanced Settings Tool Help for details on using the settings. Respectively, the settings are 
Administration—Set the Minimum Length for Locations, and Administration—Set the Minimum 
Length for Subscriber-Defined Alternate Extensions.

• You can control whether subscribers can use the Cisco Unity Assistant to view the alternate 
extensions that you specify in the Cisco Unity Administrator. To do so, see the Subscribers > Class 
of Service > Profile page. The Subscriber-Defined Alternate Extension table displays the alternate 
extensions that the subscriber adds.

• Neither the Cisco Unity Administrator nor the Cisco Unity Assistant will accept an extension that 
is already assigned to another subscriber (either as a primary or alternate extension), or to a public 
distribution list, call handler, directory handler, or interview handler. Cisco Unity verifies that each 
alternate extension is unique—up to the dialing domain level, if applicable—before allowing either 
an administrator or a subscriber to create it.

• All alternate extensions use the same transfer settings as the primary extension. 

• In many cases, Cisco Unity can activate a message waiting indicator (MWI) for an alternate 
extension. However, depending on the phones and phone systems involved, some additional phone 
system programming may be required to set this up.

Setting Up Alternate Extensions
Do the applicable procedure to add, modify, or delete alternate extensions:

• To Add Administrator-Defined Alternate Extensions, page 21

• To Modify or Delete Alternate Extension(s), page 22

To Add Administrator-Defined Alternate Extensions

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Alternate Extensions page.

Step 2 In the Administrator-Defined Alternate Extensions table, enter an extension in any row. When entering 
characters in the Alternate Extensions table, consider the following:

• You can enter an extension up to 30 characters in length. (SIP integrations can use up to 30 
alphanumeric characters.)

• Each extension must be unique—up to the dialing domain level, if applicable.

• Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

• For SIP integrations, you can also enter a valid alias for a SIP URL. For example, if the URL is 
SIP:aabade@cisco.com, enter aabade. Do not use spaces.

• Rows are numbered as a convenience. You can enter alternate extensions in any order, and you can 
have blank rows.

Step 3 Repeat Step 2 as necessary.

Step 4 Click the Save icon. Alternate extensions are enabled for all rows in the table.
21
Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0

OL-3113-08



 

Appendix: Using Alternate Extensions and MWIs
Alternate MWIs
To Modify or Delete Alternate Extension(s)

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Alternate Extensions page.

Step 2 Do any of the following:

• To modify an extension, change the extension in the Alternate Extensions table.

• To delete extensions, check the check boxes next to the alternate extensions that you want to delete.

• To remove all alternate extensions listed in the table, click Select All.

Step 3 Click the Save icon.

Step 4 Repeat Step 2 and Step 3 as necessary.

Note You can run the Cisco Unity Bulk Import wizard when you want to add alternate extensions for multiple 
subscribers at once. When you do, the Cisco Unity Bulk Import wizard appends the new alternate 
extensions to the existing table of alternate extensions, beginning with the first blank row.

Alternate MWIs
You can set up Cisco Unity to activate alternate MWIs when you want a new message for a subscriber 
to activate the MWIs at up to 10 extensions. For example, a message left at extension 1001 can activate 
the MWIs on extensions 1001 and 1002.

Cisco Unity uses MWIs to alert the subscriber to new voice messages. MWIs are not used to indicate 
new e-mail, fax, or return receipt messages.

Setting Up Alternate MWIs
Cisco Unity can activate alternate MWIs. Note that depending on the phones and phone systems, some 
additional phone system programming may be necessary. Refer to the installation guide for the phone 
system.

To enable alternate MWIs for extensions, do the following procedure for each subscriber who needs 
alternate MWIs.

To Set Up Alternate MWIs for Extensions

Step 1 In the Cisco Unity Administrator, go to the applicable Subscribers > Subscribers > Messages page.

Step 2 Confirm that the Use MWI for Message Notification check box is checked.

Step 3 Click the Add button located beneath the MWI Extensions table to add a row to the table. By default, 
the first row in the table contains an “X” to indicate the primary extension assigned to a subscriber. If 
you want one more extension and do not need to activate the MWI on the primary extension, you can 
also modify the first row.

Step 4 Enter the applicable extension in the Extension field of the table. MWIs are automatically enabled for 
all rows in the table. When entering characters in the MWI Extensions table, consider the following:
22
Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0

OL-3113-08



 

Appendix: Using Alternate Extensions and MWIs
Alternate MWIs
• Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

• Enter , (comma) to insert a one-second pause.

• Enter # and * to correspond to the # and * keys on the phone.

Step 5 Click the Save icon.

Step 6 Repeat Step 3 through Step 5 as necessary.

Note You can run the Cisco Unity Bulk Import wizard when you want to set up alternate MWIs for multiple 
subscribers at once.

To change or delete alternate MWIs for extensions, do the following procedure.

To Modify or Delete Alternate MWIs

Step 1 In the Cisco Unity Administrator, go to the applicable Subscribers > Subscribers > Messages page.

Step 2 Do either of the following:

• To modify an extension, change the extension in the MWI Extensions table.

• To delete extensions, check the check boxes next to the rows that you want to delete in the MWI 
Extensions table, and then click the Delete button.

Step 3 Click the Save icon.

Step 4 Repeat Step 2 and Step 3 as necessary.
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Appendix: Documentation and Technical 
Assistance

Conventions
The Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0 uses the following conventions.

The Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0 also uses the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Table 9 Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0 Conventions

Convention Description

boldfaced text Boldfaced text is used for:

• Key and button names. (Example: Click OK.)

• Information that you enter. (Example: Enter Administrator in the User 
Name box.)

< > 

(angle brackets)

Angle brackets are used around parameters for which you supply a value. 
(Example: In the Command Prompt window, enter ping <IP address>.)

- 

(hyphen)

Hyphens separate keys that must be pressed simultaneously. (Example: Press 
Ctrl-Alt-Delete.)

> 

(right angle 
bracket)

A right angle bracket is used to separate selections that you make:

• On menus. (Example: On the Windows Start menu, click Settings > Control 
Panel > Phone and Modem Options.)

• In the navigation bar of the Cisco Unity Administrator. (Example: Go to the 
System > Configuration > Settings page.)

[x]

(square brackets)

Square brackets enclose an optional element (keyword or argument). (Example: 
[reg-e164])

[x | y]

(vertical line)

Square brackets enclosing keywords or arguments separated by a vertical line 
indicate an optional choice. (Example: [transport tcp | transport udp])

{x | y}

(braces)

Braces enclosing keywords or arguments separated by a vertical line indicate a 
required choice. (Example: {tcp | udp})
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Obtaining Documentation
Caution Means reader be careful. In this situation, you might do something that could result in equipment 
damage or loss of data.

For descriptions and URLs of Cisco Unity documentation on Cisco.com, see the About Cisco Unity 
Documentation. The document is shipped with Cisco Unity and is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/about/aboutdoc.htm.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
The Product Documentation DVD is a comprehensive library of technical product documentation on a 
portable medium. The DVD enables you to access multiple versions of installation, configuration, and 
command guides for Cisco hardware and software products. With the DVD, you have access to the same 
HTML documentation that is found on the Cisco website without being connected to the Internet. 
Certain products also have .PDF versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. Registered Cisco.com 
users (Cisco direct customers) can order a Product Documentation DVD (product number 
DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation
Registered Cisco.com users may order Cisco documentation at the Product Documentation Store in the 
Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/
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Documentation Feedback
Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. to 5:00 p.m. 
(0800 to 1700) PDT by calling 1 866 463-3487 in the United States and Canada, or elsewhere by 
calling 011 408 519-5055. You can also order documentation by e-mail at 
tech-doc-store-mkpl@external.cisco.com or by fax at 1 408 519-5001 in the United States and Canada, 
or elsewhere at 011 408 519-5001.

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by completing the online feedback 
form that appears with the technical documents on Cisco.com.

You can submit comments about Cisco documentation by using the response card (if present) behind the 
front cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you will find information about how to:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories, security notices, and security responses for Cisco products is 
available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you 
can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS) 
feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release them, 
and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerability 
in a Cisco product, contact PSIRT:

• For Emergencies only— security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which 
a severe and urgent security vulnerability should be reported. All other conditions are considered 
nonemergencies.
26
Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0

OL-3113-08

mailto:tech-doc-store-mkpl@external.cisco.com
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
http://www.cisco.com/go/psirt
http://www.cisco.com/en/US/products/products_psirt_rss_feed.html
mailto:security-alert@cisco.com


 

Appendix: Documentation and Technical Assistance
Obtaining Technical Assistance
• For Nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to 
encrypt any sensitive information that you send to Cisco. PSIRT can work with information that has been 
encrypted with PGP versions 2.x through 9.x. 

Never use a revoked or an expired encryption key. The correct public key to use in your correspondence 
with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page 
at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

The link on this page has the current PGP key ID in use.

If you do not have or use PGP, contact PSIRT at the aforementioned e-mail addresses or phone numbers 
before sending any sensitive material to find other means of encrypting the data.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco 
Technical Support & Documentation website on Cisco.com features extensive online support resources. 
In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC) 
engineers provide telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and technologies. The website is 
available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com user 
ID and password. If you have a valid service contract but do not have a user ID or password, you can 
register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting 
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support & 
Documentation website by clicking the Tools & Resources link under Documentation & Tools. Choose 
Cisco Product Identification Tool from the Alphabetical Index drop-down list, or click the Cisco 
Product Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by 
product ID or model name; by tree view; or for certain products, by copying and pasting show command 
27
Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0

OL-3113-08

mailto:psirt@cisco.com
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
http://www.cisco.com/techsupport
http://tools.cisco.com/RPF/register/register.do


 

Appendix: Documentation and Technical Assistance
Obtaining Technical Assistance
output. Search results show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the information before placing a 
service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—An existing network is down, or there is a critical impact to your business operations. 
You and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operations are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired, while most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.
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Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• The Cisco Product Quick Reference Guide is a handy, compact reference tool that includes brief 
product overviews, key features, sample part numbers, and abbreviated technical specifications for 
many Cisco products that are sold through channel partners. It is updated twice a year and includes 
the latest Cisco offerings. To order and find out more about the Cisco Product Quick Reference 
Guide, go to this URL: 

http://www.cisco.com/go/guide

• Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo 
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at 
this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco Systems, as well as customer support services, can be 
obtained at this URL:

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection is an interactive website for networking professionals to share 
questions, suggestions, and information about networking products and technologies with Cisco 
experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking
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• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and 
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and 
coincidental.

© 2006 Cisco Systems, Inc. All rights reserved.
30
Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0

OL-3113-08

http://www.cisco.com/en/US/learning/index.html

	Ericsson MD-110 Serial Integration Guide for Cisco Unity 4.0
	Integration Tasks
	Task List to Create the Integration
	Task List to Make Changes to an Integration
	Task List to Delete an Existing Integration

	Requirements
	Integration Description
	Call Information
	Integration Functionality
	Integrations with Multiple Phone Systems

	Planning How the Voice Messaging Ports Will Be Used by Cisco Unity
	Preparing for Programming the Phone System

	Programming the Ericsson MD-110 Phone System
	Creating a New Integration with the Ericsson MD-110 Phone System
	Testing the Integration
	Integrating a Secondary Server for Cisco Unity Failover
	Requirements
	Integration Description
	Setting Up the Secondary Server for Failover

	Changing the Settings for an Existing Integration
	Deleting an Existing Integration

	Appendix: Using Alternate Extensions and MWIs
	Alternate Extensions
	Setting Up Alternate Extensions

	Alternate MWIs
	Setting Up Alternate MWIs


	Appendix: Documentation and Technical Assistance
	Conventions
	Obtaining Documentation
	Cisco.com
	Product Documentation DVD
	Ordering Documentation

	Documentation Feedback
	Cisco Product Security Overview
	Reporting Security Problems in Cisco Products

	Obtaining Technical Assistance
	Cisco Technical Support & Documentation Website
	Submitting a Service Request
	Definitions of Service Request Severity

	Obtaining Additional Publications and Information



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


